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2 ProSail 

Dongle 

 

 

    

 

    

 A dongle is a small USB connector that plugs into a USB port on your computer.  

 For many ProSail machines, a dongle is required for the software to run. 

Licence Agreement 

This is a legal agreement between you, the end user, and Armstrong-White 

Automation (NZ) Ltd.  This software is owned exclusively by Armstrong-White 

Automation (NZ) Ltd.  Armstrong-White Automation (NZ) Ltd grants you the 

right to use this software by way of this licence agreement.  It is important to 

note that if you loose the software CD, it will be replaced free of charge.  

However, if you loose the dongle which protects this software, you have lost 

your entire software licence.  Hence it is recommended that the dongle be 

insured for the full replacement cost of this software licence.  If however the 

dongle is only damaged, it will be replaced in exchange for the damaged dongle 

for no more than the material cost of the dongle. 

Disclaimer 

 Armstrong-White Automation (NZ) Ltd is not liable or responsible to the 

purchaser or user for loss or damage caused, or alleged to be caused, directly or 

indirectly by the software or hardware and its attendant documention, including 

(but not limited to) interruption of service, loss of business, or anticipatory 

profits. 

USB to Serial converter 

 

    

 

    

 

  

 With the ProSail plotter mkIII or the ProSail digitiser, the dongle is an optional 

extra and is not supplied as standard.  With these machines the software will 

run so long as the USB cable from the “USB to Serial converter” is plugged into 

the computer (the machine does not need to be turned on, just the USB cable 

plugged in to the computer). 
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Introduction 

The Nesting software is used for arranging (nesting) 2D panels (patterns) on the 

fabric.  Panels can be moved around, flipped and rotated.  There is also a semi-

automatic compaction facility and optionally (if enabled) a fully automatic nesting 

facility. 

It can control a ProSail plotter, plotter/cutter or digitiser. 

DXF, HPGL and NTV files created by other CAD software such as AutoCad, CorelDraw, 

MPanel, ForTen etc can optionally (if enabled) be imported. 

DXF and NTV files can optionally (if enabled) be exported. 

Nesting 

PanelMaker is a 2D patterning program where 2D panels (patterns) can be generated 

and modified.  There are 3 basic modes to shaping in PanelMaker : 

PanelMaker 

Additionally panels can be scaled, divided or digitised. 

Panel Mode 

Curve Mode 

Seam Mode 

Considers the global dimensions of the panel. 

Considers the local shape of individual curves in the panel. 

Considers the seam widths around the panel. 

This manual covers both the Nesting software and the PanelMaker software.  If you only 

have the Nesting software please disregard the sections of this manual relating to 

Shaping, Scaling, Divide and Triangulation which are only in PanelMaker.   

Whether you have PaneMaker or just Nesting, the program name is the same : 

PanelMkr.exe 
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Units 

Selecting Units from the File menu : 

This dialogue determines the current units and decimal places displayed in all of the 

dialogues throughout the program. 

Although this determines the units that will be displayed, you can enter values using any 

units.  For example if you want to enter 1.5 feet into a dialogue, you can enter 1.5f or 

1.5’ or 1f6i or 1’6”.   Then after pressing the Enter key it will be converted to the current 

units you selected in the Units dialogue. e.g. 457.2mm 

If the current field is already displayed in the units that you want then when you enter a 

new number there is no need to add the units letters after the number.  Just type the 

number. 

Most dialogues have a % button that toggles between % and the current units when you 

click in it. 

If for example mm is displayed in the % button then fields in the dialogue will be 

displayed in mm. 

If however %  is displayed in the % button then some fields will be displayed as a %.  

Then if you enter a number into these fields it will be assumed to be a % unless you add 

the units letters to the end of the number. 

Some examples 

   entered   converted 

   4.2f    1280.2mm 

   1.4m   1400.0mm 

   4.2f - 7mm  1273.2mm 

   10i    254mm 

   100+10.7   110.7mm 
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Nesting 

The Nesting Window shows the panels on the fabric.  The icon near the top far right of 

the screen has two modes that govern the display of the Nesting Window : 

In this mode, the view of the panels is distorted horizontally so they can all 

be seen on the screen.   

Clicking on this icon (or pressing the F4 key on the keyboard) will produce a 

dotted rectangle inside the Nesting Window.  Using the mouse, position this 

rectangle at a location you wish to zoom in on.  You can change the zoom 

scale by typing a number on the keyboard between 1 and 5.  Then click the 

mouse to zoom that rectangle.  The icon will then look like the following : 

In this mode, the view of the panels is drawn undistorted.  The horizontal and 

vertical scroll bars around the Nesting Window can be used to move around 

the nesting lay to see all the panels.   

Clicking on this icon (or pressing the F5 key on the keyboard) will revert to 

the mode above so all the panels can be seen on the screen. 

(x,y) coordinates of the mouse cursor on the fabric.  x is the distance along 

the table.  y is the distance across the table.  (0,0) corresponds to the bottom 

left corner (Home). 

length  =  total length of fabric required. 

efficiency = (total panel area) / (length x fabric). 
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Nesting 

Flip the highlighted panel(s) vertically.  A flipped panel will have a rectangle 

drawn around its panel number to identify it is on the other side of the fabric.  

This may be important if the fabric has a different texture on each side. 

Same as above except flipped horizontally.  

Permanently remove the highlighted panel(s) from the nesting window.  To 

undo the operation use Ctrl+Z or Undo from the Nest menu. 

Duplicate the highlighted panel(s).  If Rename after Duplicate is ticked in the 

Preferences dialogue from the Nest menu, the duplicated panels will have a 

new number.  Otherwise they will have the same number. 

Highlight all panels of this colour and style.  To first display a colour in this icon, 

click the mouse in any panel.   This icon will then become the colour and style 

of that panel. 

Will display a dialogue where the panel(s) number can be entered.  If you don’t 

want the panel(s) to have a number, enter 0. 

Will remove the highlighted panels and save them to a specified file.  These files 

can later be read using Open from the File menu. 

Click on a panel to highlight it.  To re-position a panel, click on it, and with the mouse 

button still down drag it to the required location.    To highlight several panels, either 

hold the Shift key down while clicking on them or click the mouse outside a panel and 

with the button still down drag a dotted rectangle around the desired panels.  Another 

way to select a panel is to use the left or right arrow keys on the keyboard. 

The following icons apply to the highlighted panel(s) : 

Will display a message asking for the panel(s) text to be entered.  The Text will 

be plotted next to the panel number in a seam.  Note that if you enter too much 

text, it may appear off the edge of the panel. 

The colour or style of the highlighted panels can be changed by selecting Colour or Style 

from the Nest menu. 
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Nesting 

Rotation 

Rotate the highlighted panel(s) clockwise by 90 degrees.  

Rotate the highlighted panel(s) by 180 degrees.   Alternatively you can right 

click on one of the panel(s) using the right mouse button and select 

rotate180.  Or simply right double click on the panel(s). 

If you just want to swap two panel positions (with rotating), highlight one then 

right click on another and select swap. 

Rotate the highlighted panel(s) clockwise by 

the specified angle (-ve for anticlockwise).  

The following dialogue will appear :  

If Only for nesting is ticked, the panel(s) are rotated on the Nesting Window 

but not in the Shaping Window of PanelMaker.  This is probably the most useful 

mode especially if a panel has been digitised and you don’t want its (x, y) 

coordinates rotated in the Shaping Window.  The rotate 90 and rotate 180 

icons use this method.  

With this method the cumulative angle the panel has been rotated is 

remembered and is displayed in this dialogue.  Setting the angle to zero will 

rotate the panel back to its original orientation (the same orientation seen in 

the shaping window). 

If Only for nesting is not ticked, the panel is rotated in the Shaping Window 

as well as on the Nesting Window. 

Rotate the highlighted panel visually using the mouse. 

Click and release the mouse button on this icon to display a dotted line drawn 

between the centre of the panel and the mouse.  Move the mouse to a location 

on the screen (away from the panel), then click the mouse and (with the 

mouse button still down) drag the mouse to rotate the panel.  When the mouse 

button is released the panel will have been rotated.  The further from the panel 

you do the dragging, the more control you have. 

Rotates the highlighted panel(s) so the end points 

on the top curve becomes parallel with the fabric 

edge. 

Rotates the highlighted panel(s) so the end points on the bottom curve 

becomes parallel with the fabric edge. 
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Nesting 

Group (Ctrl+G) / Ungroup (Shift+Ctrl+G) 

Sometimes it is useful to link panels together so they act as though they are one 

panel on the Nesting window.  i.e. So they compact, flip, rotate etc as one panel.  

For example, if the following two panels are grouped together they will not be 

separated after clicking the compaction icon (which otherwise they would have 

been) : 

To group panels together, highlight the desired panels and select Group from the 

Nest menu.  To ungroup panels, click on any one of the panels in the group and 

select Ungroup from the Nest menu. 

To separate panels of different colours and style (fabric) into separate files : 

(i) Click on one panel of a given colour and style to make the following icon that 

colour and style. 

 

(ii)  Then click on this icon to highlight all panels of this colour and style. 

 

(iii) Then click on this icon to save all those highlighted panels into a file.   

 

Enter a suitable file name.  If a message comes up telling you that the file 

already exists and asks you if you want to overwrite it, either say Yes and 

overwrite it or say No and then use a different name. 

 

Repeat the above process until there are only panels of one colour and style left on 

the Nesting Window.  They can then be nested and plotted.  To plot the panels we 

previously saved, select Open or Add from the File menu and open one of those 

files, nest and plot.  Continue until all panels have been plotted. 

Separating Colours 

Undo (Ctrl+Z) / Redo (Shift+Ctrl+Z) 

Keyboard Ctrl+Z/Shift+Ctrl+Z will undo/redo the last operation.   Alternatively 

these can be selected from the Nest menu.  Multiple Undo/Redo are allowed. 
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Nesting 

New Panel 

Selecting New from the File menu: 

Adding panels 

When you select Open from the File menu, the current panels on the Nesting 

Window are replaced with the panels from the file you are opening.  If instead you 

select Add from the File menu the panels in the file you are opening will be added to 

the end of the current panels on the Nesting Window.  These files will be highlighted 

and hence if you wish can easily be renamed with a letter next to their number by 

clicking on the T icon. 

Multiple files can be selected in the Open or Add dialogues by holding down the shift 

or Ctrl key on the keyboard while you click on their name.  This is a quick way to add 

several files to the Nesting Window. 

Create a new rectangle or circle of the specified size. 

If seam is non-zero a seam will be placed all the way around the panel adding to the 

size of the panel. 

If X count is +ve, the panel width will be  X * Xcount and there will be vertical cut 

lines with a spacing of X dividing the panel.  If Xcount is –ve, the panel width will be 

X with Xcount evenly spaced sections.  

E.g. if X count is 1  the panel width will be X and have no divisions. 

E.g. if X count is 2, the panel width will be 2 * X and will have 1 vertical division. 

E.g. if X count is –3, the panel width will be X and will have 2 vertical divisions. 

Y count works the same as X count but in the vertical direction. 

If draw internal curves is ticked in Preferences from the Nest menu, these 

divisions will be visible on the Nesting Window. 

If replace current panels is ticked, the current panels on the Nesting Window will 

be replaced with this panel.  Otherwise this panel will be added to the current 

panels. 
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Fabric Start 

Displays the following dialogue allowing you to define the starting edge of 

the fabric for fabric that has been cut at an angle.  After selecting OK to this 

dialogue, select the compaction icon to re-compact the panels to the new 

starting edge of the fabric. 

This icon will restore the fabric to a 

rectangular edge. 

Panel Origin 

Specify the lower left (X, Y) coordinates for an imaginary rectangle 

enclosing the highlighted panel.  The top right coordinates are also 

displayed. 

Sometimes you want to save a copy of the nested panels to a different place 

(for example a memory stick to take to another computer).  You could use Save 

As... from the File menu but you will have to change the directory each time 

you do this between this new directory and the directory you normally save 

your files.  Also after saving, the software will think any changes have been 

saved and will not prompt you to save the file to its normal place later. 

To get around these problems use Save a Copy... from the File menu. 

Save a Copy... 

Nesting 
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Compaction 

Compacts all panels towards the left.  The vertical position of the panels is 

not changed.  You need to arrange the panels in a left to right order before 

clicking this icon. 

When you click in this icon, the software imagines all the panels are down the far right of 

the screen.  It then moves one panel at a time as far as possible to the left until it either 

hits the left of the screen or another panel.  The order in which it chooses the next panel 

to compact depends upon each panel’s left edge.  First it compacts the panel which has 

the left most left edge.  It moves this panel as far to the left as it can.  Then the next 

panel with the left most left edge is pushed as far to the left as possible.  This is repeated 

until all panels have been compacted.   

So it is up to you to arrange the panels in the desired left to right order before clicking 

this icon.  Compaction horizontally does not care if a panel overlaps other panels at the 

time you click the icon.  It only cares about the left edge of each panel. 

In the following example the panels are in the correct order before compacting. 

i.e. The left edge of panel 1 is to the left of the left edge of panel 2 : 

In the following example the panels are not in the correct order before compacting : 

Compaction : Horizontally 

There are 3 ways to compact panels: 

(i)   Horizontally 

(ii)  Individually 

(iii) Autonesting (Extra module) 
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Compaction 

The following example is a nesting lay of panels that have been compacted using the 

compaction horizontally icon.  However panel 6 has ended up in the wrong place. 

To solve this we need to move panel 6 until its left edge is to the right of the left edge of 

panel 5 but before the left edge of panel 8.  (alternatively we could have moved panel 5 

so it is in front of panel 6).  It doesn’t matter if panel 6 overlaps panel 8.  The nesting 

software is only interested in each panel’s left edge.   If you want to see a vertical line 

showing the left most edge of a panel when you drag it, click the right button on the 

mouse rather than the left button when you drag the panel.  Another useful feature of 

using the right button is that it makes sure the panel does not move vertically when you 

drag the mouse. 

Note : if you want a panel to be hard up against the edge of the fabric, make sure you 

move the mouse toward that edge.  The nesting software won’t allow you to push the 

panel off the fabric. 

Now click on the compaction horizontally icon : 

Reset Compaction: Often you might arrange panels to have the correct left edge before 

clicking compaction horizontally.   However after the compaction the order may change.  

This would indicate that if you click it again it would then give a different result.    

To prevent this happening, the software remembers the order of the panels before its 

first compaction and uses that order each time you compact.   If you later drag a panel it 

will recalculate that panels order based on its new left edge. 

However because the software is using this combination of original panel positions and 

new panel positions to determine the order in which panels are compacted it can start to 

behave unpredictably if panels are repeatedly shifted and then compacted.  To solve this 

problem, periodically select Reset Compact from the Nest menu. 
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Compaction 

Panels may also be compacted individually.  While holding down the Ctrl key on the 

keyboard, click in and drag the panel you wish to compact.  As usual a dotted 

outline of the panel is drawn as you drag.  However when the panel intersects 

another panel, the dotted outline attaches itself to that panel and does not move 

until you have moved away.  If you release the mouse, the panel will stay in that 

position hard up against the other panel.  Panels can be compacted in any direction 

with this method.  e.g. Useful for compacting rectangles vertically. 

 

Panels may also be moved and compacted using the arrow keys on the keyboard.  

Hold down the Ctrl key and click any of the four arrow keys to move a highlighted 

panel in that direction.   The panel will stop moving when it hits another panel. 

Compaction : Individually 
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Moves panels to the autonesting window.  They will be removed from 

the nesting window (so you can work on other panels).  

Autonesting (Extra module) 

If pair panels is ticked (recommended), autonesting will first pair similar panels 

(typically one panel rotated 180 degrees and placed next to a similar panel) before it 

starts autonesting.  This normally produces the best results but occasionally does not if 

there are only a few panels. 

 

If allow 180 is ticked (recommended) autonesting is allowed to rotate panels by 180 

degrees. 

 

Gap between panels is the minimum gap allowed between panels.  Normally this will 

be the same gap specified in the Plot Options window from the Fabric menu 

(recommended).  However you can override this if you wish and specify other. 

It is usually more efficient to specify a gap between panels of at least 1mm(0.04”) 

even if you are using a plotter and can have the panels touching each other.  This is 

because the autonesting method is much slower when a value less than 1mm is used.  If 

using a cutter you will probably want at least 10mm anyway due to the vacuum table. 

This optional module will take panels off the Nesting Window and move them to the 

autonesting window where it automatically arranges them horizontally and vertically to 

minimise waste.  It uses a genetic algorithm that progressively produces a better result 

over time. 

Because it runs in the background you can continue using PanelMaker/Nesting with other 

panels during this process.  This process will continue until you tell it to stop.  It will then 

move the panels with their new positions back to the nesting window.  
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Autonesting will continue searching for more efficient arrangements until you tell it to 

stop.  While it is doing this you can continue working on the nesting window as normal 

with other panels (or if using ProSail, Pagoda etc continue designing). 

Each time it finds a better solution it will display it on the autonesting window. 

 

When you click Stop it will then move the panels with their new positions back to the 

Nesting Window.  If you have since placed other panels on the Nesting Window it will ask 

you if you want to save them first. 

 

If instead of Stop, you click the go away icon at the top right of the window, autonesting 

will ask you to confirm if you want to discard the changes made by autonesting.  If you 

say Yes, whatever is currently on the nesting window will remain.  Warning: if you hadn’t 

saved the panels before you entered autonesting, they will be lost.  You might possibly 

get them back by using Undo from the Nest menu. 

If you click the compact horizontally icon with panels that were previously compacted 

with autonesting it will probably change their order.  However if you re-arrange the 

left most order of the panels (use the right mouse button to drag horizontally) you 

will probably be able to get them in the correct order for it to work.  You would 

however have to have used at least the same gap between panels in autonesting as 

you have in the Plot Options window. 

Exceptions can occur especially if for example one panel has been pushed up into the 

hollow bottom side of another panel (like the panels drawn on page 9).  In which case 

they would need to be grouped. 

Compatibility with “Compaction : Horizontally” 

Autonesting (Extra module) 
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Fabric Width 

Select Width from the Fabric menu: 

Largest panel : The width of the largest panel in the file.  Hence this is the 

minimum possible Fabric width that can be used.  Clicking in 

this button will place this value in the Fabric width. 

Nesting Width : The width of the nested panels.  A Fabric width less than this 

will necessarily shift the panels vertically to keep them on the 

fabric. 

Last Fabric : The last Fabric width the panels were saved with. 

Enter the Fabric width the panels are to be nested on.  Alternatively you can click 

the mouse on any of the following three buttons to use that width : 

Fabric 
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General 

Comments The large edit field at the top of the window is useful for saving 

any comments regarding this particular fabric file. 

Table size Sets the maximum plottable length for your plotter.   Usually 

set at 100% but can be reduced if required (if for example 

some rails are removed from the plotter).  The maximum 

plottable width is set and can not be changed. 

Fabric edge shift This moves all of the plotting and cutting across the table.   

This will of cause reduce the maximum fabric width that can be 

used.  Usually set to 0. 

Gap between panels  When panels are being compacted (see pages 12 to 16) 

panels are pushed close together.   How close they are allowed 

to get is specified by Gap between panels.  A value of at 

least 10mm is recommended if using a cutter.  Anything 

smaller than this and the resulting strip between panels 

probably won’t be held down hard enough by the vacuum 

resulting in the fabric moving when cutting.  For a pen plotter, 

any value can be used but it is recommended to use at least 

1mm. 

Fabric 

Different fabric files can be saved for different types of fabric.  For some fabric you might 

want a slower plotting speed or have a larger gap between the panels etc.   

These fabric files are specified, opened and saved in Plot Options from the Fabric 

menu. 

Alternatively you can simply ignore these files and just change the information each time 

for different fabrics.  In this case the software will store this information in the default file 

called untitled.pst. 
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z-home Angle Cumulative angle of rotation that the cutter z-axis will rotate 

before it will automatically do a z-axis homing cycle.   That is 

to say after the cutter head has rotated by this amount it will 

check its position to make sure it is in the correct direction.  

The smaller this angle the more often the cutter head does 

this check.  For a cutter mkIII, this can be kept very large (say 

10,000).  For a cutter mkI or II it should typically be about 

1000. 

 

warn before cutting Plotter/cutters first do plotting and then cutting.   If warn 

before cutting is ticked, a message will be displayed before 

cutting starts asking you if you want to start cutting. 

 

cutter bounce  This is an old method only used by old ProSail plotter/cutters 

to reduce how hard the cutter head comes down and hence 

increase the life of the plastic table surface.  If  cutter 

bounce is ticked and a non-zero value is entered, the cutter 

head will not come down so hard.   The more you increase the 

value, the softer the head will come down.   However, over a 

certain value, the head will come down hard and then go up 

again and then down again.   (The method used by cutter 

bounce is to send the signal for the head to go down, then 

after a delay equal to the cutter bounce value you have 

entered, a head up signal is given which slows the downward 

movement.  This is then following after another delay by the 

down signal again to continue the downward movement).   

The optimal value will vary from machine to machine but 

around 30 seems to produce a soft movement for most 

machines. 

 

partial cutting This is very rarely used.  If plot is non-zero, the external cut 

lines of the panels will be cut in sections.  The length of each 

section will be equal to cut and the gap between each section 

will be equal to plot.  This is useful for example if you want to 

roll up the panels after cutting and send them to another 

company. 

Fabric 
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Fabric 

Speed 

move speed Speed the plotter will move when the pen and blades are up.  This 

is normally high. 

pen speed Speed when the pen is down.  This is normally quite slow.  Pen 

speeds depend upon the fabric being used and the type of pen.  

For example for Kevlar you will probably need to reduce the pen 

speed to prevent the pen from jumping as it goes over the fabric. 

blade speed  Speed when the corresponding blade is down.  This is normally a 

medium speed. 

pen delay  Time in milliseconds the plotter waits for the pen to go up or down 

after giving it the signal to go up or down.  If for example the pen 

is taking too long to go down, the plotter may start moving before 

the pen has gone down or may continue plotting for a short time 

before the pen has come up.  Hence to allow more time for the pen 

to go up or down, specify a larger (not smaller) pen delay. 

blade delay  Similar to pen delay but for the corresponding blade. 

acceleration  Defines how quickly the plotter gets up to speed.  3 is the highest 

acceleration, 1 is the lowest.  It is not recommended that both 

speed and acceleration are both set to their highest level.  Doing 

so risks the possibility of the plotter stalling. 
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smoothing The size of the arcs used for smoothing when using the pen.  

Low corresponds to small arcs, high corresponds to large 

arcs. 

cusp angle If the angle for any cusp is greater than cusp angle, no pen 

smoothing is applied at this cusp.  This is to make sure that 

corners that are supposed to be corners remain as corners and 

are not smoothed.  A typical value would be 15 degrees. 

Fabric edge pen lift If the pen comes close to the edge of the fabric, the pen will 

lift (not plot this part of the curve) to prevent the pen from 

catching on the edge of the fabric.  See page 24. 

Fabric 

Pen 

Files which are generated from 3D moulding software (or other CAD design software and 

read as DXF files) are typically made up of a series of straight line segments.  Even if the 

design curves are smooth splines or circles they will often be exported from the design 

software as straight line segments.  Depending upon the design software sometimes 

these can be quite coarse with relatively large angles between each segment. 

If the plotter was to plot these curves like this, the plotter speed would have to start and 

stop at each cusp.  Not only would this take a long time but would also give a jagged 

curve.  To avoid this the plotting software uses smoothing where each cusp is replaced 

by an arc.  The larger the arcs the smoother the curve will become but the more the 

curve departs from the design point.  If however the arcs are too small then the plotter 

will need to slow down then speed up while doing the arcs.  
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smoothing The size of the arcs used for smoothing when using the 

corresponding blade (see explanation on top of previous page). 

cusp angle If the angle of any cusp is greater than cusp angle, no blade 

smoothing is applied at this cusp.  This is to make sure that 

corners that are supposed to be corners remain as corners and 

are not smoothed.  At these locations the cutter will have to 

stop, lift the blade, rotate it and then put it down again.  A 

typical value would be 15 degrees. 

min. radius If the radius of the arc the software has used on any cusp needs 

to be smaller than min radius, the cutter will draw this arc with 

the pen rather than the blade.  This prevents the blade from 

blunting or snapping.  It is temping to make this very small to 

prevent this from happening but you run the risk of blunting or 

snapping the blade.  Typically the Rotary blade needs at least 

15mm.  The Straight blade can be closer to 5mm. 

fabric edge blade lift If the corresponding blade comes close to the edge of the 

fabric, the blade will lift (not cut this part of the curve) to 

prevent the blade from catching on the edge of the fabric.  See 

page 24. 

Fabric 

Rotary blade / Straight blade 

The ProSail cutters can use one of 2 blade types.  A rotary blade or a straight blade.  The 

Rotary blade and Straight blade tabs specify the cutting characteristics for each.  

When you select Plot from the Plot menu, you then specify which of these 2 blades has 

been mounted. 

If you are only ever going to use the Rotary blade you can go to hardware from setup 

from the plot menu and deselect straight blade (see page 70) .  Otherwise you need to 

have it ticked to see the Straight blade tab in Plot Options. 
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radius compensation  Only applies to Rotary blades: when cutting circles or arcs the 

blade tends to be steered outward by the plastic table surface.  

Ticking radius compensation will try to adjust for this by over 

steering the blade inwards slightly.  This only offers an 

improvement, it does not solve the problem which of course is a 

physical limitation relating to the length of blade that is cutting 

into the plastic.  The problem does not exist for straight blades. 

 

cut under Although can be used with Straight blades, this is most 

applicable to Rotary blades: A Rotary blade will overcut the start 

and finish of lines because of the length of the blade in the 

plastic.  Namely the blade is not a point.   If needed this overcut 

can be reduced by entering a value for start and end.   e.g. If 

you find the cutter over cuts by 5mm at the start of a line and 

4mm at the end of a line, you might try entering up to 4mm for 

start and up to 3mm for end.  Normally these are just set to 0 

since the over cutting is not normally a problem for most 

applications.   For a straight blade you probably want to specify 

–ve values to force overcutting. 

 

concave extra For concave corners on the outside of a panel or any corners on 

cutouts inside a panel it might be beneficial to reduce the 

amount of overcutting by even more to make sure there is no 

overcut.  For these corners, start and end are effectively 

increased by concave extra. 

Fabric 

If you find the blade has to go up and down too often when cutting curves then you 

probably need to increase cusp angle.  Though if too large it will smooth corners. 

If you find some tight sections of curves are plotted rather than cut you could reduce 

min. radius, though if too small it will blunt the blade.  You could also decrease cusp 

angle but then you will have more blade ups and downs. 
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Tell the nesting software that the fabric is smaller than it actually is.  For example you 

may be using fabric that is 914mm wide but you tell the nesting software that the 

fabric is really 894mm wide by specifying 894mm in the Fabric Width dialogue.  

Hence we are wasting 10mm of fabric each side.  The fabric should be laid so the 

edge of the fabric averages the reference line marked on the table (some inside and 

some outside the line).  We then need to tell the software to shift its plotting 10mm 

(50% of 20mm) in from that reference line.   This is done by setting Fabric edge 

shift in the General tab of Plot Options to 10mm : 

Since the straightness and width of fabrics vary over their length, it may be necessary to 

take measures to allow for this and also to prevent the pen or blade from catching on the 

edge of the fabric. 

Method 1 : fabric edge shift 

Fabric 

The second method is to tell the nesting software the fabric width is the actual width 

of the fabric but tell the plotter not to plot when it gets to within say 10mm from the 

edge of the fabric.  This is done by specifying 914mm in the Fabric Width dialogue 

and specifying 10mm for pen lift (and maybe a value for blade lift) in the Pen tab 

of Plot Options (blade lift is specified in the Rotary blade and Straight blade 

tab). 

This method does not waste material and since the lines it does not draw are usually 

only seam lines it is not so important to plot them.  One exception to this rule is for 

panels that come from a cross-cut sail.   In this case the straight edge of each panel 

will only be approximated by the curved edge of the fabric. 

Method 2 : pen lift/blade lift  (most common method) 
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Plotting 

Lay the fabric out and tape it to the table.  Masking tape is good for this.  Usually it is 

sufficient just to tape the cloth at the start of the table.  If using a cutter some people 

prefer to tape the entire side of the cloth to prevent air escape from the vacuum.  Use 

the reference line on the table nearest you to lay the fabric to.   

Cloth Bow : Because fabric sometimes has a bow in it, it is recommended that you try 

to average the cloth edge on the line so at some places the cloth edge is inside the 

reference line and at others it is outside.   

Cloth Curl : If using a cutter with fabric that has a tendency to curl, it is recommended 

that the roll of fabric is turned upside down to prevent the edges from curling up and 

possibly catching on the cutter. 

Vacuum : If using a vacuum table with a cutter it is important to cover the remainder of 

the table that is not being used.  Any holes that are left uncovered will dramatically 

reduce the power of the vacuum.  For some materials it may be necessary to tape the 

entire fabric edge to prevent air escaping or the edge of the fabric moving when the 

cutting blade is near it. 

For porous materials it may be necessary to cover the entire fabric with a thin layer of 

plastic.  Very thin plastic is available and is quite cheap. 

 

After telling the plotter to plot, the plotter will plot the first table lay (frame).  If there is 

more than one frame the plotter will draw an L-Mark down the end of the table and a 

dialogue will appear on the screen asking you if you want to “continue next frame?”. 
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However, this effect is not so important if Plot complete panels only is ticked 

in Preferences from the Plot menu. 

Pull the fabric down the table until the L-Mark drawn on the fabric lines up with the start 

line on the table.  The corner of the L-Mark needs to be a specified distance up from the 

table reference line.  This distance (typically 10mm) is specified by L-Mark in the 

Hardware dialogue (see page 70).   Pushing a pin through the fabric to line up with a 

preset L-Mark hole on the table is a convenient way to do this. 

It is quite acceptable to push the plotter by hand if you find it is in the way.  Tape the 

cloth down again and when ready select Yes to the dialogue to continue the next frame.  

The plotter will now plot the next frame. 

Although fabric edge shift and fabric pen lift explained on page 24 can largely 

adjust for fabric bow, there still exists a problem when lining the fabric up for the 

next frame.  Namely a line drawn directly across the table down the end of the 

table will no longer be directly across the table when the fabric has been pulled to 

the front of the table.  This is because by pulling the fabric along the table and 

lining it up to the reference line on the table again, you in effect need to rotate 

the fabric slightly to keep it on the reference line. 

Problem of fabric with extreme bow 
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Plotting 

Select Plot from the Plot menu : 

To plot all the panels for all frames (tables) make sure the All radio button is selected 

and click the Plot button. 

If you only want to plot some of the frames click the From radio button and enter the 

frame number for the first frame and the frame number for the last frame you want 

plotted.  They can be the same number.  The distances to the right give the position 

along the cloth that plotting will start and end.  You can compare these with the ruler 

drawn on the Nesting Screen.  Then click the Plot button.   

 

Plot Selected Panels  This is an alternative to the Plot button.  It will only plot the 

panels that are selected (black) on the nesting screen. 

lines  This determines which type of panel lines are sent to the plotter.   If 

cut is ticked, all lines that are defined as cut lines (for example all 

external lines in a panel are cut lines by default) will be sent to the 

plotter.  This is unrelated to whether your machine is a plotter or a 

plotter/cutter.  For example if you have a plotter (not a cutter) and 

want the external panel lines to be plotted, you need to make sure cut 

is ticked.   

 Normally both plot and cut are ticked but sometimes you may want to 

redo just the plotting or just the cutting and so only one would be 

ticked. 

 Tick plot if you want panel plot lines (most internal panel lines are 

probably plot lines) to be sent to the plotter.   

 back is a special case and is described on the next page.  Normally it 

is not ticked. 

screen plot only If ticked, selecting Plot or Plot Selected Panels will only draw the 

lines on the screen.  It will not send the information to the plotter.   

This can serve as a useful check if there is a problem. 

cut lines Specifies what tool is used to cut the cut lines.  Selecting pen is useful 

if there is a problem with the cutting mechanism on the cutter.  The 

straight blade option is only available if it has been enabled in the 

Hardware dialogue (see page 70). 

Plot Options Displays the Plot Options window for changing speeds etc (see page 

18). 
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Stopping 

If the plotter has a stop button, press the stop button to quickly stop the plotter.   

If using a ProSail plotter or cutter you can also stop them by 

either clicking the mouse on the Stop button on the screen or 

pressing any key on the keyboard. 

When it has stopped, a message will be displayed on the screen asking you if you wish 

to continue plotting.  If you select Yes, the following window will appear : 

On rare occasions you may want to plot on both sides of the fabric.  To do this 

you must first tell PanelMaker which lines/text are on the back of a panel.  This 

is done in the shaping window by selecting a line/text and selecting plot back 

in the popup menu.  See chapter titled “Shaping : Panel Mode”. 

First we plot the back lines/text by turning the fabric over and rather than placing the 

fabric on the usual reference line on the table, place it on the reference line on the 

other side of the table (i.e. the line indicating the maximum plotting width).   Select 

Plot from the Plot menu and tick back.  It doesn’t matter if plot and cut are ticked.  

Then click the Plot button.  The plotter will now plot only those lines marked as plot 

back.  When the plotter has finished, turn the fabric over and place against the 

normal reference line.  Select Plot from the Plot menu again.  You will notice that 

back is no longer ticked.  Make sure plot and cut are ticked and then click the Plot 

button to plot and cut out the panels. 

Special case of plotting on both sides of the fabric 

Clicking the <<back button will scroll back through the lines that have been plotted.  

As you scroll, the desired line is highlighted on the nesting screen.  To see its location 

better click on the zoom button to see the following :   

Click Continue to continue plotting from the highlighted line.  You can also change 

speeds at this time if you wish. 
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Accuracy 

At the end of plotting a frame, the ProSail plotters and cutters test to see that they 

have come back to the exact position they are supposed to.  If they have not, a 

message will be displayed stating the accuracy giving figures for X, Y (and Z if 

applicable).  On rare occasions this may occur as a result of resonance that can not be 

avoided.   More commonly it will occur if the plotter is bumped or has caught the 

fabric or hit something on the table.  If the inaccuracy keeps occurring then there is a 

problem and you should contact Armstrong-White Automation telling us exactly what 

numbers were displayed for each of X, Y and Z.   Also select Bug Report from the 

About menu.  This will create a file called “bugger.dat” that can be e-mailed to us. 

Move To 

Select Move To from the Plot menu.  This is an alternative to pushing the machine 

by hand.  There are four buttons identifying the corners of the table.  Clicking one of 

them will make the machine move to that corner.  Pressing the Esc key on the 

keyboard will cancel. 

Plotting 
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Plotting 

Select Preferences from the Plot menu : 

optimise plotting After plotting or cutting a curve, the plotter will move to the 

next nearest curve to plot or cut.   If not ticked the plotter may 

choose a curve that is a long way from where it currently is.   

Hence optimise plotting is usually ticked.  

smooth curves Sometimes curves on panels may not be as smooth as they 

should be and are made up from a relatively small number of 

flats.   This is often the case when reading panels from other 

CAD programs using HPGL or DXF.   If smooth curves is ticked 

the software will smooth these curves out by adding extra 

points on the curve.  If you want the curve to be plotted as a 

set of flats, then turn smooth curves off. 

plot panels individually Plotter will totally plot and cut each panel before it moves 

on to the next panel.  This might cause problems with the pen 

catching if using a cutter and the cloth curls up after cutting.  If 

not ticked, a plotter/cutter would first plot all panels, then cut 

all panels. 

cut internal first Plotter will cut any internal cut lines before it cuts the boundary 

of the panel. 

allow panels inside other panels Software will not prevent you from plotting if 

one panel is totally inside another.  Normally you would want to 

be warned of this. 

save backup plot: ”BackupPlot.plt” Software will automatically save a copy of the 

current nesting panels before plotting. It will be saved as 

BackupPlot.plt and can be opened as a normal nesting file later 

if for example something goes wrong while plotting. 
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Plotting 

Consider plotting the following panels that do not fit totally inside the table : 

If plot complete panels only is not ticked, only panels 1 and 2 will be completely 

plotted with panels 3 and 4 only partially plotted.  An L-Mark will draw drawn at the end 

of the table which will be the start of the next table lay.  With this method, you will need 

to be very careful in lining up between table lays : 

If plot complete panels only is ticked (most common method), only panels 1 and 2 will 

be plotted.  An L-Mark will be drawn to mark the start of the next table lay.  This 

method is more accurate since you do not need to be so careful lining up the lines 

between table lays.  However there may be more table lays required : 

In the special case of a panel being longer than the table size, the panel will 

automatically be split regardless of whether plot complete panels only is ticked or not. 
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panel numbering : 

The following items determine how the panel numbers are plotted on the panels.  If 

you don’t want the numbers plotted turn them all off: 

number panels that have seams 

 Plotter will draw panel numbers on all panels that have a seam and they will 

be drawn inside the seam. 

number all panels that don’t have seams 

 Plotter will draw panel numbers on all panels that do not have a seam. 

move numbers in to prevent clipping at fabric edge  

 Numbers will be moved in from the edge of the panel if needed to prevent 

pen lift (see the “Plot Options” dialogue) from clipping them. 

number in corner of panels 

 Put panel numbers in a corner rather than along one side. 

size  

 The size in mm of the panel numbers. 

draw : 

 internal lines Plotter will plot (or cut) all internal lines inside the panel.   Seam 

allowances are not considered internal lines. 

 seam lines  Plotter will plot all seam allowances. 

 text Plotter will mark any text that has been created using the text 

shaping facilities described in the chapter titled “Shaping : Panel 

Mode”. 
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home off fabric  Plotter will first move to the far side of the table width before 

homing.   The idea is to keep the pen off the fabric during 

homing down the length of the fabric.  This can be useful if the 

fabric has a tendency of curling up. 

start plotting from end of table Not commonly used, but if ticked, the plotter 

will first go to the end of the table and start plotting from that 

end first.   For this to work you must also have optimise 

plotting ticked. 

park After plotting a table lay the plotter will come to a stop.  The 

position it stops at is specified by park.   Park X is the 

distance down the table from Home.  Park Y is the distance 

across the table.  Some people like a large Park Y so the pen 

and knife is away from the fabric when the fabric is being 

pulled down between table lays. 

eliminate double cutting  Horizontal and vertical lines on adjacent panels that touch 

will be cut only once.  Useful if rectangles are nested close together.  

Note : This does not apply to angled lines or curves. 

check marks Plotter will draw the specified number of evenly spaced check marks 

on all panel sides that are over the specified length.   These can be 

used as an aid in sticking panels together : 

outward plotting Plotter will always make sure the pen and knife are moving outward 

toward the edge of the fabric for lines that are within the specified 

distance from either edge of the fabric.  This prevents the edge of 

the fabric from possibly being pulled in by the pen or knife.  

However it does take the plotter longer since it needs to do extra 

moves so its plotting/cutting can be in this direction. 

homing : 
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Shaping : Panel Mode 

Select Shaping from the Edit menu or double click on a panel on the Nesting Window to 

display the Shaping window.  This is enabled if you have PanelMaker.  This window has 

three modes depending upon which of the following three icons is selected : 

Panel Mode 

Shows the panel sides and any internal curves for the current panel.   

The X and Y coordinate displayed corresponds to the “Current Point” which is encircled.  

To select another point click the mouse near it.  

The curve which is green corresponds to the “Current Curve”.  To make a different curve 

the Current Curve click the mouse near the dotted line connecting its end points. 

Current Point 

X, Y : There are two ways to change the X or Y value of the Current Point : 

(i) Type in a new X or Y value using the keyboard.  Then hit either the Tab key or 

Enter key on the keyboard to recognise the change.  The Enter key will keep you 

in the same field.  The Tab key will take you to the next field.  Before entering a 

value into a field you need to make sure that field is highlighted.  If it isn’t, hit 

the Tab key on the keyboard until it is highlighted or double click in the field. 

(ii) While holding the Ctrl key down on the keyboard click the mouse as close as 

possible to the Current Point and with the mouse button still down drag the point 

to the desired location.  See page 45 regarding the need to hold down the ctrl 

key or not. 

Current Curve 
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Shaping : Panel Mode 

R If the Current Curve is an arc or a circle, the radius can be changed. 

 

L Displays the straight line length between the ends of the Current Curve.   

(To see the girth around the curve you need to be in Curve Mode.  The girth 

will then be displayed at the bottom of the window)  

 If L is ticked, the length can be changed. 

 The icon to the right of length determines how the Current Point will move if 

you change the length.  Click on this icon to toggle between the two options: 

  

The Current Point will move parallel with the dotted line between the 

Current Curve end points.  Hence the length of the curve next to the 

Current Curve (common Current Point) will have to change. 

The length of the curve next to the Current Curve will not change.  

Instead it will rotate so its length remains the same. 

  

 If you are unlikely to want to change lengths you can untick L.  This makes 

using the Tab key more efficient and prevents accidentally changing length. 

 

 

move-All If ticked and the Current Point is on the boundary of the panel, changing X 

or Y will move the entire panel.  Rather than just moving the Current Point 

the entire panel is moved so the Current Point is at that location. 

 If however the Current Point is on an internal curve (rather than the panel 

boundary) only the selected curves will move. 

 Remember to untick move-All when you are finished with this mode. 
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Shaping : Panel Mode 

IMPORTANT : It is important to note that although the points can be placed at any 

location, they should not be changed to the extent that the panel folds over itself.  Even 

though it may look correct on the screen the panel will have been inverted and will cause 

problems in PanelMaker.  If you hold down the right arrow key on the keyboard, the 

Current Point should move around the panel in an anticlockwise direction. 

You can select multiple internal curves by dragging a rectangle around them (click the 

mouse and with the button still down drag the resulting rectangle around) 

or 

holding down the Shift key on the keyboard and click on curves (in a similar way to 

selecting multiple panels on the nesting screen).   

 

All operations : dragging, scaling, deleting, copying, rotating, duplicating, changing curve 

type or pen type will apply to all selected curves.  In the picture above, the purple and 

green curves are all selected.  Although there are several selected curves, there is still 

only one Current Curve and one Current Point which are green. 
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Add a new object.  The resulting display will show a selection of object types.  

The last object type that was added is currently selected.  If this is not the 

object type you want to add now, click the mouse on the desired one.  If its already the 

desired type, there is no need to click on it.  If you want to cancel press the Esc key on 

the keyboard. 

Just above the object types are instructions on how to proceed. 

Adds a cross. 

Adds a circle. 

Adds an internal curve or several connected internal curves.  To add a single 

curve, click and release the mouse at the desired start of the curve and then 

click and release again at the desired end of the curve. 

To add several connected internal curves (e.g. to make a window), the Shift key 

needs to be held down.  With the Shift key held down, click the mouse at the 

desired locations.  Before clicking the last point, release the Shift key. 

To produce a closed set of curves, the last point should be close to the first.  All 

these internal curves can later be shaped in Curve Mode. 

Adds a rectangle. 

Adds an L section. 

Adds a slot. 

Shaping : Panel Mode 
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Adds another side to the panel or another side to an internal set of connected 

curves.  Click the mouse near a corner to add another curve at that point. 

Adds a chamfer or round to a corner.  Click the mouse near a corner to display 

the following dialogue giving a choice of chamfer, arc or b-spline : 

If arc is selected, an arc will round off the corner.  If b-spline is selected, a b-

spline will round off the corner.  Unlike an arc a b-spline has the advantage of 

adjusting its shape so it remains tangential to the sides if their angle is later 

changed.  However a b-spline is not a true arc and hence not perfectly circular. 

Adds an internal curve with text on it.  This is the same as selecting a curve and 

then clicking the Text button (see next page). 

Shaping : Panel Mode 

Chamber width 

Length along each side where chamfer starts 

Depth of chamfer 

Radius 

Length along each side where radius starts.  If sides are curved then this 

distance will necessarily be slightly different on each side 

Depth of radiused corner 

The arc, b-spline or chamfer can later be changed by selecting Change Round 

from the Window menu. 
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Text desired text. 

Size height of text. 

h start distance along curve. 

v distance out from curve. 

other end if ticked, h is the end distance from the end of the curve (rather than 

start distance). 

rotate 180 rotate text by 180 degrees. 

other side text is on the other side of the curve. 

 

If text only is selected (most common) only the text will be plotted, the curve it is 

attached to will not be plotted even though it appears on the computer screen.   If 

Text_line is selected both the text and the curve will be plotted. 

 

The plotting of text can be turned on or off using the  draw:text check box in the 

preferences dialogue from the Plot menu.  See page 31. 

Displays the following dialogue for adding (or changing) text to the current 

curve.   Hence to add text you must first have a curve.  However optionally 

these curves do not need to be plotted. 



40 ProSail 

Shaping : Panel Mode 

In PanelMaker, panels are made up of curves which in turn are made up of a 

set of Adjustment Points.  Segment changes the distribution of these 

Adjustment Points into different curves.  Clicking the Segment button displays the 

following dialogue : 

Each click of Increase curve will increase the Current Curve by 

taking the next Adjustment Point from the adjacent curve. 

Each click of Decrease curve will decrease the Current Curve by 

removing the current point from it. 

Automate the Increase curve method for all curves based 

on a specified max. smooth angle. 

With max. Increase All curves PanelMaker looks at the angle between all 

adjacent lines.  If this angle is less than max. smooth angle it will assume these 

two lines are part of a curve.  Otherwise it will assume they are separate lines 

forming a corner.  The trick is to specify a max. smooth angle that is large 

enough to combine the segments you want combined but small enough to not 

include the corners. 
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Fully reduces the Current Curve into flat segments.  This is the 

same as repetitively clicking the Decrease curve button. 

Fully reduces all curves to individual segments. 

This is not commonly used but can be useful in special 

situations.  If a curve is simply a straight line (i.e. a point at 

each end) as it would be if max. Decrease curve was used, B

-Spline curve will make the curve into a b-spline curve with 

an angle (tangent) at its ends.  PanelMaker will choose the 

angle of these tangents based on the length of each adjacent 

side.  The greater the length of the adjacent side, the closer 

the tangent will be to parallel with that adjacent side.  If all 

three sides are the same length the tangents will equally 

bisect the corners. 

Again not commonly used.  Makes all the straight line curves 

in the panel into b-splines as above.  This is useful for 

smoothing a panel.  Curves other than straight line curves will 

remain the same. 

Turns the current curve into a spline curve.   This is the same 

as clicking on the Type button and clicking on the spline icon. 
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The internal angle of a corner can be specified.  Highlight the desired point 

(you also need to consider which side of the point you want highlighted as this 

will be the side that is rotated).  Then click on the Angle button to display the following : 

The angle specified is the internal corner angle of the selected point.   If 

ignore shape in sides is ticked it will not include the shape in the adjacent 

sides in its calculation of the angle.  Otherwise it will. 

If selected point is ticked, the other end of the highlighted curve will move 

to achieve the specified corner angle at the selected point.   

If other end is ticked the selected point itself is moved to achieve the 

specified angle at the selected point. 

(i)   If you have selected an internal curve and the selected point is not joined 

to any other curves, the angle specified is the angle to the horizontal. 

(ii)  If rather than specifying a corner angle, you want to rotate the selected 

curves by a specified amount (or the entire panel),  use Rotate from the 

Window menu. 

(iii) If you just want to rotate an object, see page 44. 

Variations : 



43 ProSail 

Shaping : Panel Mode 

free Current Curve will have no angle constraints at the Current Point (most 

common). 

tangent Current Curve will be tangential (parallel) to its adjacent curve at the 

Current Point. 

right angle Current Curve will be at right angles to its adjacent curve at the 

Current Point. 

Slope continuity 

Line segments and B-splines with one or more Adjustment Point can be 

made to be tangential to or at right-angles to its adjacent curve at the 

Current Point.  Even if the panel shape is changed the curve will adjust to 

retain these angles. 

plot Selected curves will be plotted. 

cut Selected curve will be cut. 

plot back Selected curves will be marked as being on the opposite side of the 

panel.  It will normally not be plotted or cut.  To plot or cut it you need to 

tick the back check box in the Plot dialogue.  See page 27 

 Another use for plot back is if you want to keep a record of a curve but 

don’t want it plotted.   You can later change its style to plot or cut if desired. 

Plotting style 

Defines the plotting style of the selected curves. 

Visually scales the curves for clarity of viewing.  Most useful in Curve Mode for 

shallow curves.  Note that this is only a visual effect and does not change the 

shape of the panel. 

Loops through all the panels.  The current panel’s number is displayed above it.  

Another way to loop through the panels is with the Page Up or Page Down keys 

on the keyboard. 

To enter the Shaping window at a desired panel double click on that panel in the 

Nesting Window or highlight the panel then select Shaping from the Window 

menu. 

If show All panels on the shaping window is ticked, all panels on the nesting 

window are able to be viewed in shaping.  Otherwise only those panels which are 

highlighted on the nesting window are available. 



44 ProSail 

Shaping : Panel Mode 

Scale Uniformly scales the selected curves (or entire panel if the boundary is 

selected) by a specified amount. 

Rotate Rotates the selected curves by a specified amount.  If the Current Point 

is on the boundary, the entire panel including internal curves are 

rotated. 

Origin defines the centre of 

rotation. 

Clicking horizontal or vertical 

will calculate the angle 

required to make the current 

curve horizontal or vertical. 

 

Flip Horizontal Horizontally flips the selected curves (or entire panel if the boundary is 

selected) about the Current Point. 

Flip Vertical Vertically flips the selected curves (or entire panel if the boundary is 

selected) about the Current Point. 

Reflect Reflects the selected curves (or entire panel if the boundary is selected) 

about the Current Curve.  The shaping on the Current Curve is lost. 

Change Round Change the current curve to a chamfer or round, see page 38. 

New panel See New on page 10. 

Blue panel Turns a normal panel into a blue panel.  A normal panel has a boundary 

around it and often some internal curves.  A blue panel on the other 

hand does not require an external boundary.  DXF or HPGL panels are 

read as blue panels if they do not have an external boundary.  

Sometimes blue panels are useful when you don’t want the boundary of 

the panel to be cut. 

Window menu 
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Global Axes Determines the direction of the global Y-axis : up or 

down.  Up is recommended. 

show Net Draw the Net for B-Spline curves in Panel Mode.  This 

Net may be dragged if the scale scroll bar is at the 

bottom.  i.e. a scale of 1. 

snap to points Makes dragging and adding of points in Panel Mode 

snap to horizontal and/or vertical positions of other 

points when the vertical and/or horizontal position of 

the mouse is similar.  This is very useful for lining up 

curve end points, crosses, circles and for producing 

horizontal and vertical lines. 

 A quick way to change this, rather than going to the 

preferences dialogue is to press the F9 key on the 

keyboard.  This can be done at any time, even while 

dragging or adding objects.  The display at the bottom 

of the shaping window will say either F9 : snap on or 

F9 : snap off to identify the current state. 

selected line color  This is the colour of the “current curve”. 

group line color This is the colour of any additional curves that might 

be selected. 

use the last plot/cut/back style when adding 

 If ticked, any curves that are added will be of the 

same style as the last added curve. 

Ctrl key required to start Adjustment 

 If ticked, you need to hold down the Ctrl key on the 

keyboard in order to drag the end of a curve with the 

mouse.   It does take extra time to hold down the Ctrl 

key but does prevent accidentally moving points when 

you click near them.  But if you are careful you could 

turn it off. 

Preferences 

Shaping : Panel Mode 
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Zoom F4 

 Zoom in on a particular part of a panel.  A horizontal and vertical line will be 

displayed at the mouse location.  Move the mouse to the area you want to 

zoom in on.  Click and hold down the left mouse button and drag the resulting 

selection box to encompass the area you want zoomed.  When the mouse 

button is released, the selection box will be zoomed to fill the entire window.   

 A quicker way to zoom without having to go to the View menu is to press F4 

on the keyboard. 

 If you have a mouse wheel, an even quicker way to zoom in and out is to 

simply rotate the mouse wheel.  Zooming will be centred around the mouse 

location. 

 Note: there are two modes when dragging the selection box.  Either the click 

of the mouse will correspond to one corner of the selection box or the click will 

correspond to the centre of the selection box.  To swap between these two 

modes, press and release the Ctrl key while the selection box is visible. 

Unzoom F5 

 Restore the view to normal scale.  A quicker way to unzoom is to press F5 on 

the keyboard, or simply click on any part of the scale scroll bar. 

Shaping : Panel Mode 

View menu 
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Shaping : Panel Mode 

Edit menu 

Undo   Ctrl+Z Undoes the last change you made in shaping.  You can keep 

undoing repeatedly until all the changes you have made have been 

undone. 

Redo  Shift+Ctrl+Z Cancels the last undo.  You can keep redoing repeatedly until all 

the undoes have been cancelled. 

Add   Ctrl+A See Add earlier in this chapter.  This is the same as clicking the 

Add button. 

Cut   Ctrl+X Removes all of the selected curves.  This is the same as clicking 

the Cut button.  It also makes a Copy so you can later Paste it if 

you want.  Alternatively, pressing the Del key on the keyboard 

removes the selected curves but without making a Copy.  

Copy   Ctrl+C  Copies to memory all of the selected curves so they can later be 

pasted.  This also works in Seam Mode. 

Paste   Ctrl+V Pastes any previously copied curves.  These curves can also be 

pasted to other panels if desired.  This also works in Seam Mode. 

Duplicate  Ctrl+D If duplicating internal curves, Duplicate is similar to using Copy 

and Paste except it remembers the distance between where the 

original curves are and where you have moved the duplicate 

curves to.  The next time you use Duplicate, it will use this same 

distance.  This is useful for creating a line of evenly spaced 

objects.  First duplicate one, move it the desired distance from the 

original and then repeatedly duplicate. 

 If duplicating the side of a panel, Duplicate will simply add 

another side with the same shape. 

Cut single  Ctrl+S Same as Cut except it only removes the Current Curve regardless 

of how many other curves are also selected.  Useful if curves are 

grouped. 

A popup Edit 

menu is also 

available by 

right clicking 

in the 

window. 
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Shaping : Panel Mode 

Grouping menu 

Group If several curves are selected, Group will turn them into one entity.   After 

grouping, clicking in any one of these curves will select all of them.  

Ungroup 

 Ungroups all selected curves so they can be selected individually.   It also 

ungroups any selected curves that are joined.  In the above picture the 4 

sided shape would turn into individual curves that you can move apart.  If 

you want to keep connected curves grouped together you could select all 

curves in the panel and click on Group only if connected. 

Group only if connected 

 Of the selected curves it will group together only those curves that join to 

each other. 

Print menu 

 Prints the current panel picture. 
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Shaping : Curve Mode 

Curve Mode 

Displays the Current Curve in local coordinates.  You can enter Curve Mode either by 

clicking on this icon or double clicking near the dotted line connecting the ends of a 

curve in Panel Mode. 

The relationship between Panel Mode and Curve Mode is summarised by the following 

examples.  The left end of the curve in Panel Mode always corresponds to the left of the 

curve in Curve Mode : 
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Shaping : Curve Mode 

To select an Adjustment Point and display its X and Y position, click anywhere near the 

Adjustment Point (preferably significantly above it so as not to accidentally move it).  

There are three ways to change an Adjustment Point’s X or Y : 

(i)   Click on an Adjustment Point and with the mouse button still down, drag it to 

the desired location.  The point will only move vertically.  To move it 

horizontally as well, hold the Ctrl key down on the keyboard while dragging. 

(ii)  Click on the red arrow (and with the button still down) drag it horizontally to 

change X. 

(iii) Type the desired X or Y value using the keyboard.  Then hit the Enter or Tab 

key on the keyboard. 

There are 3 different coordinate systems. 

global : X and Y are relative to the origin in Panel Mode. 

local : X and Y are in local coordinates across the curve (most common). 

triangular : Similar to local coordinates except LHS and RHS is used rather than 

X and Y. 

move-All If ticked, changing the Y value for one Adjustment Point will uniformly 

change the values for all the Adjustment Points.  Useful for scaling curves 

up or down. 
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Shaping : Curve Mode 

Adds a new Adjustment Point to the curve.  After clicking Add, a vertical line 

appears at the mouse location.  Move it until it is approximately where you 

want and click the mouse button.  If the exact required X value is known, it 

can then be entered through the keyboard. 

Removes the highlighted Adjustment Point. 

Toggles the X and Y display between % and absolute units (e.g. mm).  Both 

X and Y are expressed as a % of the straight line length between the ends 

of the curve. 

This is the length measured around the curve.  Hence this is greater than 

the straight line length between the ends of the curve. 

girth = 

The vertical position of the curve in the window can be moved with the mouse if desired.   

This is often done if the curve is hollow and hence falls below the viewing rectangle.  To 

move the curve, click the mouse very close to the horizontal line drawn between the 

ends of the curve and with the mouse button still down, drag the curve up or down.  

When in the required position release the mouse button.  Note that this does not change 

the shape of the curve, it is only a visual tool. 

If ticked, changing Y (or dragging an adjustment point) will scale the entire 

curve.   Note : the Y value initially needs to be non-zero for this to work. 
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Shaping : Curve Mode 

Click on one of the following icons to change the curve type : 

Curve is made up of line segments.  i.e. Made up from a set of connected 

straight lines : 

Curve is a Spline.  This is an efficient way to produce a smooth curve.  A 

special case applies if there is only one Adjustment Point in which case the 

curve is an arc.  In Panel Mode this arc will have a radius field that can be 

changed. 

Curve is a B-Spline.  B-Splines produce nice looking curves.  However 

unlike Splines, the Adjustment Points don’t lie on the curve.  The straight 

lines connecting the Adjustment Points are called the B-Spline Net.  One 

useful feature of B-Splines is that the ends of the Net are tangential to the 

ends of the curve.  Hence the Slope Continuity set to Tangent in Panel 

Mode can be used on a B-Spline curve to force the curve to blend smoothly 

into its adjacent curve. 

Number of points Number of Adjustment Points required. 

If only the number of points is changed the points will automatically be evenly spaced 

in X.  If however the curve type is changed the following dialogue will be displayed 

asking if you want the points to be evenly spaced : 
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Shaping : Seam Mode 

Seam Mode 

Displays the seams on the sides of the panel.   

out is the seam added to the outside of the panel size defined in Panel Mode.   

in is an additional line drawn inside the panel size.  in is useful for example if you want 

to plot a line inside the panel that the outer seam edge will fold to.  in can also be -ve 

if desired.  In order to change a value of in, it must be ticked.  If you are not likely to 

want to change a value of in, it is recommended you remove the tick to prevent them 

from accidentally changing. 

To highlight another side, click the mouse near it or use the left or right arrow keys on 

the keyboard. 

Note : The ends of the seams are only drawn in Seam Mode as 90 degree corners.  This 

is just a display method to allow the scale scroll bar to work in a predictable way.  The 

above panel will actually be formed as follows : 
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Shaping : Seam Mode 

Make all seams equal to current seam   

 Gives all the sides of the panel the same seam as the currently 

highlighted side. 

 If you only want to make some of the sides have the same seam width, 

use cut and paste.  See page 47. 

 

Increase panel by outer seam   

 Removes the outer seams around the panel but will increase the size of 

the panel to take its place.   Hence the overall panel will stay the same 

size but will have no outer seam line. 

 

Reduce panel by inner seam   

 Removes any inner seams around the panel and decreases the panel size 

by that amount. 
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Sometimes it is necessary to fold a seam on the edge of a panel (a turnover 

seam).  However if the seam width is large and/or the panel has a large 

amount of shape on it (as is often the case with the outside edge of an awning) it is 

difficult to fold the material without it creasing.  A solution is to cut small nicks 

periodically along the seam. 

nick size :  Width of nicks.  This can be entered as a percentage of the seam width 

if desired. 

angle per nick : This determines the number of nicks on that curve.   If the curve has a 

cumulative angle change along its length of 20 degrees and angle per 

nick is 5 degrees, then 4 nicks will be placed on that curve. 

The scroll bar lets you adjust how the nicks are distributed along the curve.  With the 

scroll bar at the bottom they will be evenly spaced along the curve.  With the scroll bar at 

the top the nicks will be spaced based on angle so they will bunch up in tighter regions of 

the curve. 

Regardless of where the scroll bar is the total number of nicks will be determined solely 

by angle per nick. 

Once you have defined nicks for one curve, you can easily copy this to other curves in 

this panel or to other curves on other panels by using copy and paste (Ctrl+C and Ctrl+V 

or right click the mouse to display the popup menu). 

Shaping : Seam Mode 
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Scaling 

Highlight the panels you want to scale on the nesting window and select Scale from the 

Edit menu to display the following dialogue : 

Panels may be scaled horizontally (horizontal) or vertically (vertical) or evenly in both 

directions (both). 

The Scale is calculated from the top number divided by the bottom number.  The reason 

for doing it this way is so you can compare a current dimension on a panel with the 

desired. 

Example 1) : If the width of the panel is currently 500.0mm (as per the dialogue shown 

above) and we want the panel to be scaled evenly until the panel width is 750mm : Click 

the width= 500mm button to place this value in the bottom number.   Then type 

750mm in the top number.   PanelMaker will divide the two numbers to produce a scale 

of 150%.  Click Ok to scale the panel by this amount. 

Example 2) : To make a panel 20 larger, type 120 in the top number leaving 100 in the 

bottom number giving a scale of 120%. 

If area is selected the panel will be scaled evenly in both directions but the scale will be 

based on area rather than dimension. 

Note : If scaling horizontally or vertically, circles will not become ellipses but will remain 

circles.  Also all curves will retain exactly their same % shape.  This means that even if a 

panel is scaled horizontally it will change size vertically if there is a curve on the top or 

bottom of it  (as shown below) 

Scaling will be enabled if you have PanelMaker. 
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Divide 

Highlight the panel(s) you want to divide on the nesting window and select Divide 

from the Edit menu.   If the width tab is selected the panel will be divided starting 

from the bottom up based on width and seam : 

Note that panel 1c is not to the full width.   If you want panel 1c to be to the full 

width and panel 1a to be smaller, rotate the panel by 180 degrees before dividing.  

If you want the seams to run at a different angle, rotate the panel by that angle 

before dividing. 

If you desire the seam to be placed on the other side of the panels, tick move 

seam to other side. 

If rename panels is ticked, the divided panels will have an extra letter placed after 

their name.  Otherwise they will just be the same name as the original panel. 

Divide can be used to slice a large shape such as a large flat cover into panels of a 

specified fabric width.   Use PanelMaker to first generate the full size of the cover 

(the triangular co-ordinate system in Curve Mode can be useful for this) and then 

use Divide to create the panels.   After Dividing, it is sometimes more efficient to 

rotate every 2nd panel by 180 degrees before compacting them. 

Dividing a panel(s) based on a width 

Divide will be enabled if you have PanelMaker. 
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If a small amount of shape is required on each of the seams, this will be done 

automatically if shape divide seams is ticked : 

A spline curve with the same shape as an arc will be placed on the top and 

bottom of each panel with a % Depth as specified.  Hence the longer the panel 

side, the greater the actual depth of the curve.  The spline will have the number 

of points specified which can be used for adjusting the shape in PanelMaker 

later.  Note that this will increase the width of the panel and hence the width 

specified will need to be smaller than the fabric width to allow for this. 

Divide 
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A seam is added to one side of each cut line.  The side it is added to depends upon 

the direction used to create the cut line.   If the cut line was created by dragging 

from left to right for example, the seam will be placed below the line.  However if 

move seam to other side is ticked, the seam will be on the other side. 

If rename panels is ticked, the divided panels will have an extra letter placed 

after their name.  Otherwise they will just be the same name as the original panel. 

 

If desired a cut line can also be a shaped curve.   The only requirement is that the 

ends of the curves end outside the panel. 

Dividing a panel(s) based on defined curves 

First you need to create lines that you want the panel divided along.  Go to the 

shaping window of PanelMaker and add internal lines in the usual way by using the 

Add button.    These lines must completely cut the panel.  Namely both ends of 

the lines must be outside the panel.  Then mark these lines as "cut" lines.  

As many lines can be created as you wish.  Leave the shaping window, highlight 

the panel(s) and select Divide from the Edit menu.   If the cut lines tab is 

selected, the panel(s) will be divided along these lines. 

Divide 



60 ProSail 

Select Triangulate from the Digitise menu: 

Triangulation will be enabled if you have PanelMaker. 

Triangulation uses connecting triangles to define the size and shape of a panel.  The size 

of each triangle is defined by the length of its 3 sides. 

If triangles are drawn over a 3D shape and their sides measured, they can be entered 

into this window to develop the corresponding panel required to cover that 3D shape. 

An example would be a boat cover.  You can think of the adjacent sides of the triangles 

as being hinges that unfold to form a flat panel. 

Initially only a vertical line is displayed.  To add triangles, repeatedly select Add from the 

Edit menu.  (or use Ctrl+A on the keyboard as a shortcut) 

Clicking the mouse near a corner of a triangle will highlight the right most sides of the 

triangle and the side and diagonal dimensions can be entered for that triangle. 

Triangulation 
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This icon displays the Table window with the side and diagonal 

measurements for all triangles.  These can be changed and extra triangles 

added by simply entering more data. 

This is an alternative and much quicker way to enter the data than using Add 

from the Edit menu. 

It can also be useful to identify if any erroneous dimensions have been 

entered.  

Note that the first line does not have a side measurement. 

By default each triangle is flipped relative to the previous triangle.  If you want 2 or 

more triangles with the same “fanned” orientation, highlight the triangle and click on the 

fan check box: 

The Table window identifies which triangles are fanned by displaying a –ve diagonal 

measurement. 

Triangulation 
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This icon displays the curved boundary of the panel.  The small circles indicate 

that this point is a cusp.  To replace a cusp with a smooth curve (spline), 

simply click the mouse near the circle.  Clicking again will turn it back into a 

cusp. 

Typically for most panels you will probably just want 4 cusps in the panel: 

Below is an example of a panel with 2 cusps.  Any number of cusps from 2 upwards is 

possible. 

Triangulation  
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Click this to add the panel (including splines) to the nesting window and 

leave the Triangulation window.   

If any of the dimensions are invalid (the sum of 2 sides of any triangle are 

less than its 3rd side), the software will display a warning and highlight 

the offending triangle. 

This icon will take you back to the triangle display. 

The information entered into the Triangulation window can be saved in the usual way 

using the File menu.  These BTC files are only for use with the Triangulation window and 

are separate from the PLT files used in the nesting window. 

When deciding where to position the triangles on the 3D object, you need to take into 

account the direction of the diagonals that will best generate the shape.  As a general 

rule this will be in the direction that the fabric will be tensioned. 

There is also a trade off between the number of triangles used and the accuracy.  If in an 

ideal world you were able to measure each triangle extremely accurately, then the 

greater the number of triangles you used, the more accurate will be the resulting panel.  

However in reality there is a limit to how accurate the measurements will be and since 

any error in these measurements can be cumulative, it is better not to use too many 

triangles.  

Triangulation  
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Digitiser from the Digitise menu will connect to the ProSail Digitiser if it is connected. 

The first 2 icons control the screen with the digitiser (Digitise mode).  

Moving the digitiser carriage will move the red cross-hairs around the 

screen. 

The example above is a pattern that has been digitised.  It contains 1 closed group 

(drawn in white) which contains 4 corner points and 2 spline points.  Plus 1 unclosed 

group (drawn in black) which contains 3 corners points.  Plus one circle. 

The digitising software operates in 2 modes : Digitise mode and Screen mode: 

The next icons control the screen with the mouse (Screen 

mode).  Moving the mouse will move the red cross-hairs 

around the screen. 

Digitiser 
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While this icon (“Insert” icon) is highlighted, clicking the button on the 

digitiser while the red cross-hairs are near a previously digitised line, will 

insert a point at that location.   

If double clicking, the inserted point will be a spline point. 

This icon is useful for adding extra points or points that were previously 

missed. 

While this icon (“Add” icon) is highlighted, clicking the button on the 

digitiser will have the following effect: 

Single click: Adds a new corner point. 

Double click: Adds a new spline point.  Though the point will not 

appear curved until the next point is added.  This 

option needs to be used with caution because a spline 

has to be relatively shallow.  You should not try to 

digitise a spline curve that changes angle more than 

about 90 degrees from start to finish.  If you need to 

do this split it up into multiple spline curves.   

 You can also toggle digitised points between corner 

and spline points later using the Toggle icon explained 

on the next page.  Hence you can just make all points 

corners points (Single click) initially and then change 

them later if you wish. 

Click & Hold: Adds a final point to the current group of connected 

points.  The next point to be added will be on a new 

group and will not be connected to this point.  If this 

final point is very near the first point on the group 

then the group will be considered a closed group and 

will be drawn in white. 

Click & Hold for 2nd time:  Ends the current panel and a fresh 

screen will appear ready for digitising the next panel.  

You can use the scroll bar to go back to this panel.  If 

you are just digitising one panel then you never need 

to do this—just click the “Add to nesting” button when 

finished. 

Digitise mode 

Digitiser 
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While this icon (“Toggle” icon) is highlighted, clicking the mouse near a 

digitised point on the screen will toggle it between a corner point and a 

spline point.  Note the warning on the previous page regarding spline 

curves. 

While this icon (“Circle” icon) is highlighted, clicking the mouse near any 

group comprising of 2 or 3 points will replace that group with a circle.  

Hence to digitise circles, digitise groups with either 2 or 3 points in them 

(i.e. an internal line or 2 joined lines).  Of course the last point in each 

group will need to be a “click and hold” to terminate the group.  Later 

when you go to the screen you can use this icon to convert each group 

into a circle. 

If there are 2 points, the first digitised point will become the centre of the 

circle.  The software will ask for a radius.  The position of the 2nd point is 

ignored. 

If there are 3 points, a circle will be created that passes through all 3 

points.  The software will display the radius of the resulting circle.  A 

different radius can then be entered if desired (the centre will remain the 

same). 

While this icon (“Delete” icon) is highlighted, clicking the mouse near a 

digitised point on the screen will delete it. 

Screen mode 

Digitiser 
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Clicking this icon will toggle the display between thick lines and thin lines.  Thick 

lines are easier to see from a distance if you want to see the screen while you 

are digitising. 

Click this to add the digitised panel(s) to the nesting window and leave 

the digitising window.   

If a panel has a closed shape, the closed shape will become the boundary 

of the panel and the panel will be drawn green. 

If there are no closed shapes in the panel, the panel will be drawn blue. 

If there are multiple closed shapes in a panel, the one with the largest 

area will become the boundary of the panel. 

Scrolls through the digitised panels if there are more than one. 

Name:  Name of the current panel. 

Digitiser 
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Digitiser menus 

Panel / preferences 

When a group is terminated in Digitise mode with a “click and hold”, the software will 

consider the group to be closed (last point is on top of the first point) if the last point 

is within max. termination gap for closed shapes of the first point. 

Normally you will want the outline of a panel to be closed.  This means you will want 

to remember where you first clicked so you can end at that point with a click and 

hold. 

Closed shapes will be drawn in white to identify they are closed.   

Unclosed shapes are black. 

If you fail to position the last point close enough for this to happen, you can select 

close last point from the Edit menu. 

LED intensity controls how bright the led lights are. 

Buzzer controls how loud the buzzer is. 

 

Laser intensity controls how bright the laser pointer is. 

Panel / make origin 

 Makes the current position of the digitiser (0, 0).  

Digitiser 
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Calibrate / x 

 This calibrates the x-axis to allow for any belt stretch. 

 First mark 2 points on the table near the rail and as far apart as possible.  

Then select Calibrate / x and follow the on screen instructions. 

Calibrate / y 

 This calibrates the y-axis to allow for any belt stretch and skew. 

 First mark 2 points across the width of the table as far apart as possible.  

These points must be exactly 90 degrees to the rail.  Then select Calibrate / 

y and follow the on screen instructions. 

Edit / undo remove 

 Undoes the last remove.  Use if you accidentally removed a point. 

Edit / close last point 

 Moves the last point in a grouped set of points to the first point in the group 

so the group becomes closed. 

Digitiser 
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Hardware 

Select Hardware from Setup from the Plot menu : 

This dialogue defines the hardware of the plotter.  Some of the values will probably never 

need changing directly.  Some of the values like x-scale etc will be automatically 

changed during the calibration process and it is unlikely you will need to change them 

yourself. 

Machine This is set for your plotter and can not be changed. 

Port This is the communication port on your computer that the plotter is 

connected to. 

Detect Click this to find out what com port to use for your plotter. 

Pen Because different pen sizes will have a different distance between their 

centre and the cutting blade, it is useful to store these different values for 

different pens.  Then when you go to plot you can select the pen you will 

be using in the plotter. 

 The Pen section stores this information.  For each pen there is an offset X 

and an offset Y.  Offset X is the distance between the centre of the pen 

and the cutting blade in the direction of the table.  Offset Y is difference 

between the pen and blade in the direction across the table (this will be 

close to zero).   

 Click Add to display a dialogue where you can add another pen with its 

own name and x, y offsets.   You can store up to 20 pens.   

 When using Shift Cutter in the calibration dialogue from Setup from the 

Plot menu, the software will automatically adjust these offsets for the pen 

you select. 

 To accurately test if Offset X and Offset Y are correct for a given pen, plot 

a square with a seam (New from the File menu).  This should have a 

seam width of 10mm all the way around it.  If not you can adjust Offset X 

and Offset Y. 
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Hardware 

L-Mark Distance from the edge of the plotted boundary that the L-Mark is 

drawn  (see pages 25 & 26). 

knife up sensor On old cutters the software will look at the sensor on the cutting head 

to get confirmation that the head is up or down.   In this way it is able 

to warn you if the head is not behaving as it should.   If there is a fault 

with the sensor this can be turned off. 

straight blade Will display the Straight blade tab in the Plot Options window and 

allow the Straight blade selection in the Plot dialogue. 

-ve X Will place Home (0,0) at the opposite end of the table.  Hence the 

cloth is loaded from the other end of the table.  However the plotting 

on the table is necessarily reversed from the display on the screen.  

For that reason it is not recommended. 

-ve Home Will place Home (0,0) at the opposite side of the table.  Hence the 

cloth is loaded from the other side of the table.  However the plotting 

on the table is necessarily reversed from the display on the screen.  

For that reason it is not recommended. 

x-scale,  

y-scale These are the number of instructions the software needs to give the 

plotter for it to move 1mm.  These numbers are automatically 

calculated when the plotter is calibrated using XY Scale in the 

calibration dialogue from Setup from the Plot menu.  It is unlikely 

you would ever change these directly.  Change with care! 

Skew Tells the software how to adjust for the angle of the plotting arm not 

being exactly 90 degrees to the table.  This number is automatically 

calculated by using Skew in the calibration dialogue from Setup 

from the Plot menu.   

X-diff Adjusts for any difference in length between the belt on one side of 

the table and the other side for a plotter/cutter.  This number is 

automatically calculated after using XY Scale in the calibration 

dialogue from Setup from the Plot menu.   

Z-offset This is the value you entered while using Zero Cutter in the 

calibration dialogue from Setup from the Plot menu. 

Centre-offset This was automatically calculated after using Shift Cutter in the 

calibration dialogue from Setup from the Plot menu.   

Change Click this to enable making changes to the calibration data.  It is 

unlikely you would ever do this.  Change with care! 
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Calibration 

Select Calibrate from Setup from the Plot menu.  This calibrates the ProSail plotters 

and cutters to allow for stretch in the belts and table movement.   It needs to be done 

when the machine is first installed and periodically afterwards (every few months is 

recommended). 

XY scale This calibrates for tension in the X and Y belts.  Place a pen in the plotter 

and click XY scale and then click OK.  The plotter will draw some marks 

on the table.   After drawing them you will need to measure between 

them with a tape measure and enter 

those measured values into the 

resulting dialogue.  The software will 

then calculate new x-scale and y-

scale values in the Hardware 

dialogue to adjust for belt tension.  It 

will then return you to the Calibration 

dialogue.  If you run XY scale again 

(thought you do not need to) the marks will probably have moved 

slightly. 

Skew This adjusts for the arm of the plotter not being at exactly 90 degrees to 

the table.  The cutter could also become out of skew if one of the cogs 

over the rails slips.  Click skew and then click OK.  The plotter will draw 

some marks on the table.   After drawing them you will need to measure 

between them with a tape measure and enter those measured values into 

the resulting dialogue.  In particular you need to measure the diagonal 

measurement very accurately.  The software will then calculate a new 

skew value in the Hardware dialogue to adjust for the angle of the arm.  

It will then return you to the Calibration dialogue. 

Zero cutter This adjusts the homing angle of the cutter blade on the ProSail plotter/

cutters.  This is very important and must be done as accurately as 

possible.  A small inaccuracy in this angle can result in blades blunting 

very quickly on fabrics like Kevlar.  The operation of zero cutter depends 

upon the version of cutter that you have.   See next page. 
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Calibration 

Zero Cutter for cutters MkI & MkII do the following : 

 Click on Zero Cutter (stage I) and then click OK.   A dialogue will be displayed 

asking for a number.  After entering a number and clicking Ok, the cutter head will 

rotate to the corresponding number.  Continue this process with different numbers 

until the blade is pointing directly down the table.  The blade will rotate 

approximately 0.3 degrees for each unit of number entered.  When happy, click the 

Esc button to permanently store this number.  To judge if the blade is straight 

down the table, it is recommended you take the blade off the cutter shaft, place a 

straight edge to the shaft face and reference this to a straight line drawn down the 

table. 

 To test (and improve) the accuracy of the blade direction select Zero Cutter 

(Stage II) and OK.  First it will ask you for the position down the table and then 

position across the table you want to conduct the test.  It will then do a  plot and 

cut line.  A window will then appear asking you how you want the angle of the cut 

line adjusted.  It will continue to do test plot and cut lines (each time moved across 

the table by 5mm) until you are happy the two lines are parallel.   

 

Zero Cutter for the cutter MkIII do the following : 

 Draw a line (at least 300mm long) near the front of the table at 90 degrees to the 

channel rail (see picture below).   Using a set-square against the channel rail is the 

best way to draw this line. Mount the supplied 160mm aluminium angle to the 

blade holder as shown below. Do not over tighten.  Note that the inner washer has 

its large flat side against the angle for rigidity.   Move the head of the cutter so it is 

over the top of the 90 degree line you drew on the table.  Turn the cutter shaft so 

the aluminium angle is roughly parallel with this line. 

 

 

 

 

 

 

 

 Click on Zero Cutter and then click OK.   Click ok to the message dialogue.  The 

next dialogue asks for a Z-home offset.  Make sure “across table” is selected.  

After clicking ok, the blade will rotate and the head will come down.  Then compare 

the blade angle with the line on the table (you can move the cutter if you wish to 

help visibility).  The current angle of the face can be changed by entering a new 

number in this dialogue and clicking ok.  The blade angle will rotate clockwise by 

approximately 0.1 degrees for each unit entered.  E.g. If the face is 10 degrees 

from the line, add or subtract 100 to the current number and click ok.   Repeatedly 

change this number and click ok until the angle is parallel with the line on the 

table.  When happy with the direction, click the Esc button.  The software will now 

return you to the Calibration dialogue.  Remove the aluminium angle and the large 

washers (the inner washer orientation has changed).  Also note the spring washer 

which is very important. 
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Shift Cutter To adjust for the distance between the pen and the blade, select Shift 

Cutter and Ok.  It will ask you for the position down the table and then 

position across the table you want to conduct the test.  It will then plot 

a cross and cut 3 short lines and ask you to measure the distance 

between the plot and cut lines.  You need to be very accurate with 

these measurements (e.g. 9.7mm is better than 10mm).  After doing 

this the software will return you to the Calibration dialogue.  Note: for 

Shift cutter to be accurate there must be no mechanical slop in the 

cutter.   If there is it will be necessary to plot a small square with a 

seam as described on the next page.  

 

 

 

 

 

 

Cutter Bounce  This is a method used on old ProSail plotter/cutters mkI or mkII  to 

reduce how hard the cutter head comes down and hence increase the 

life of the plastic table surface.  It is explained in the Fabric chapter.  

The calibration dialogue can be used to test different values for Cutter 

Bounce.   To do this, click on Cutter Bounce and then click OK. 

Draw L-Mark This draws the position of the L-Mark at the front of the table.  This is 

the position on the table the L-Mark on the fabric should be dragged to 

between frames.  The value used for L-Mark is entered in the 

Hardware dialogue.  

Draw Boundary This draws the maximum plotting size of the plotter on the table.  In 

particular the table reference line the fabric needs to be laid against. 

Calibration 

Mount the blade on the blade holder as follows (Note the orientation of the inner washer 

has changed from that used in zero cutter).  Also note the spring washer which is very 

important. 
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As a final check after calibrating it is often useful to plot a small square with a seam: 

Select New from the File menu and create a 100mm x 100mm rectangle with a seam of 

10mm (or alternatively any small panel with a seam will do).  Position the resulting panel 

in a position on the nesting window to do a trial cut.  Load some paper on the table in 

this position and tape it down.   

Select Plot from the Plot menu.   

Make sure that both plot and cut are ticked and rotary blade is selected. 

Make sure screen plot only is not ticked.  

Click the Plot button to start plotting. 

The machine should plot the inner part of the square and then cut the outer part of the 

square.  There should be an even seam width of the requested amount around this panel.   

If the seam width varies along one side it would indicate that Zero Cutter was not done 

accurately enough. 

If the seam width is wider on one side of the square compared to the adjacent side, 

adjust the offset X and offset Y values in the Hardware dialogue (select Hardware 

from Setup from the Plot menu page 70) by a small amount until the seam width is the 

same all around the panel. 

If the seam width is too large or too small, you can manually adjust for this by changing 

centre-offset in the Hardware dialogue (select Hardware from Setup from the Plot 

menu page 70) by a small amount . 
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Select PVC Joins from Setup from the Plot menu.  This is used to prevent the cutter 

blade on the ProSail plotter/cutter from catching on the joins in the PVC table top. 

PVC Joins 

If Enable knife lifting at all joins is ticked the cutter will lift the blade if it is about to 

cut a line (or part of a curve) which is within Tolerance from one of the PVC joins and at 

an angle less than Angle Limit to that join. 

Use Add to add more joins.   

Use Delete to delete the selected join.   

Click on a join to select it.   

If the selected join is across the table, Position is measured from the front of the table 

boundary (which was drawn on the table by Draw Boundary). 

To make a horizontal join, remove the tick from Across Table.  Position is then 

measured up from the lower boundary line (cloth load line which was drawn on the table 

by Draw Boundary). 

To change the Angle limit for all the joins click on the Angle Limit button. 
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Test Hardware 

Select Test Hardware from Setup from the Plot menu.  This is used to help diagnose 

problems with the ProSail plotters or plotter/cutters.  This dialogue tests the signals 

going to the plotter from the computer: 

Clicking any of these buttons should perform the associated operation.  First 

make sure that the arm and head are sufficiently away from any limit switches.  

i.e. push the machine back from the front of the table and the head to the 

middle of the arm.  Pay particular attention to the direction of travel to make 

sure it is correct when doing these tests. 

Motors Hold is useful for testing if there is any mechanical slop in the machine.   

After clicking Motors Hold, all 3 motors will hold hard (2 motors for a plotter).   

If you then physically try pushing the arm or head, there should only be a small 

movement that bounces back when you stop pushing.  If there is too much or it 

feels like something is loose, check all the belts and pulleys to see if there is 

some mechanical slop.  Of course if you press too hard, it will overcome the 

power of the motors and the machine will move (but don’t worry, this does not 

harm the machine). 

(Fan On and Fan Off are only for the cutter mkIII and controls the fans inside 

the controller box.   There is also a fan in the power box but it is always on). 

Plotter/cutter Plotter 
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Test Hardware 

 The xy-limit switches box should say on when you physically press 

either the x-limit switch at the back of the cutter over the channel rail or 

the y-limit switch at the back of the cutter head.   

 The z-limit switch relates to the limit switch inside the cutter head itself 

(remove the cover on the cutter head to see and press it).   

 On old cutters, Knife should say up when the head is up and down 
when you physically push the head down by hand.   

 (temperature is only displayed on the cutter mkIII and shows the 

temperature of the controller drives). 

When finished, click OK to display the next dialogue which tests the signals coming from 

the plotter to the computer : 

Plotter/cutter Plotter 
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DXF is the most popular file exchange format between CAD programs.  An example of a 

program that will save in the DXF format is AutoCad.  You will need to tell your design 

software to save or export a DXF file.  If it gives you an option of ASCII or Binary, you 

need to select ASCII. 

To import a DXF file into PanelMaker select Open from the File menu and select 

“AutoCad (*.DXF)” for File of type : 

DXF Import (Extra module) 

When you open a file it will list the name of all the layers in the file. 

All the layers that have a tick before their name will also be drawn.  If they are not all 

ticked you can tick them individually or you can click the Show All button. 

To see which layer name relates to the drawing click the mouse on the name to highlight 

it.  This layer will then be highlighted on the drawing.  Alternatively if you click on part of 

the drawing, the corresponding layer name(s) will be highlighted.  This is useful if for 

example you see some objects you don’t want.  You can click on the drawing to highlight 

its layer name and then untick the name. 

If you are familiar with AutoCad or similar software you will probably understand what 

layers are and how some can be hidden or frozen. 

If however you only use membrane design software (like M-Panel or ForTen etc) then 

you might not be aware of these finer details.  However all you really need to know is 

that the DXF files they generate will contain the information describing your panels but 

the information will be distributed on different layers.  Typically one layer is used for cut 

lines, one layer is used for plot lines and another layer is used for any text. However this 

can vary and there can be a lot more layers (some of which might not be needed) or 

even just one layer for everything. 
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To zoom the drawing to see more detail you can either select Zoom from the View menu 

or press F4 on the keyboard to define a zooming rectangle or more simply you can use 

the mouse wheel on your mouse to zoom.   If using the mouse wheel, zooming will be 

centred around the mouse location.  To reset the scale press the F5 key on the 

keyboard. 

Some layers may have text on them.  Some layers may have both text and lines.  To 

allow text to be included in the panel, make sure allow Text is ticked.  If allow Text is 

not ticked, no text will be included in the panel, even if a layer containing text is ticked. 

If the drawing shows discrete panels like the drawing on the previous page and you have 

unticked any unwanted layers then you can proceed.  PanelMaker will be able to see the 

discrete panels and will automatically know that the boundary of each panel will be cut 

lines. 

If however there are more lines you want to identify as cut lines then you will need to tell 

it by highlighting the layer name and clicking the Plot/Cut button.  Clicking the button 

again will put it back to a plot layer. 

When you have only the layers you want ticked and any extra cut layers are identified as 

cut layers click OK to display the following: 

DXF Import (Extra module) 

DXF files are simply a collection of lines and text.   The DXF format does not contain any 

information to identify panels.  Hence it is the job of PanelMaker to try to determine 

which lines define a panel.  If separate closed shapes is ticked (most common) 

PanelMaker will try to do this by looking for closed shapes which will then become 

separate panels on the nesting window. 

 

 

If however you just want to read the entire drawing in as one large 

object without the ability to see separate panels then leave separate 

closed shapes unticked.  A non-plotting envelope is placed around 

the drawing so it behaves as one panel.  This envelope is only there 

to allow you to select the drawing with the mouse.  It is ignored by 

the plotter and by other panels which can be compacted against the 

drawing inside this envelope.  To identify that this panel has a non-

plotting envelope around it, the panel will be coloured blue. 
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DXF Import (Extra module) 

Lines inside closed shapes (including any other closed shapes 

that completely fit inside) will become internal lines for that 

panel.  To allow for any internal lines that might slightly cross 

outside closed shapes (as seen at the bottom right), you can 

specify a clip seam allowance.  This is an imaginary seam 

around the outside of each closed shape.   Any lines within this 

seam will be considered to be inside the closed shape. 

Keep max Gap as small as possible.  Usually 0.1mm is enough.  If it is too large, lines 

that are closer than max Gap to the closed shaped (including other closed shapes) will 

become part of it. 

This example would cause problems if the gap at the top right is 

larger than max Gap. 

Closed shapes are shapes that you can entirely trace with your finger from a start point 

back to the same point.  If there are any gaps in this path they need to be smaller than 

the max Gap value you have specified. 

Closed shapes must not touch each other. They 

must be at least max. Gap away from each other.  

This example would be seen as a single panel. 
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DXF Import (Extra module) 

If there are any lines left over that don't fit inside closed shapes (including clip seam 

allowance), they will be placed inside an extra panel (blue panel) with a non-plotting 

envelope around it. 

If some of the closed shapes cross over themselves, they will still be considered a panel 

but the panel will be coloured red. 

Hence if a blue panel or red panel(s) are generated you will know that there was a 

problem with some lines. 

Units DXF files are usually saved either in inches or mm.   If you find after reading 

the DXF file it is too small or too large try changing Units. 

max. smooth angle   

 Often DXF files approximate curves as a series of straight line segments and 

are hence read by the importing software simply as straight line segments.  

However if after reading these files you want to edit the shapes in PanelMaker 

it is more useful if these straight line segments are recombined as a curve.  If 

max. smooth angle is ticked, PanelMaker will look at these lines and decide 

whether some of these should be part of a curve or remain as distinct line 

segments.  It does this by looking at the angle between adjacent lines : 

 

 

 

 If this angle is less than max. smooth angle it will assume these two lines 

are part of a curve.  Otherwise it will assume they form a corner.  A typical 

value would be 10 degrees. 

closed shapes can be multi-layer 

 Click this if any closed shapes are made up from lines coming from more than 

one layer.  This is uncommon and would normally not be ticked. 

use Text as panel name 

 Tick this if your DXF file has the name of the panel inside each closed shape. 

This will allow you to see the name of the panel on the nesting window.  For 

this to work you would have to have had allow text ticked in the previous 

dialogue. 

use filename as panel name 

 If multiple DXF files need to be added together (perhaps one panel per file), 

multiple files can be selected in the open file dialogue by holding down the 

Ctrl or Shift keys and clicking the desired files.   

 To select all files in the folder, first click on one and then press Ctrl+A 

 If use filename as panel name is ticked, the panels in each file will be 

given the same name as the file it is read from.  This is useful if separate 

closed shapes is off and multiple files are opened at once. 
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HPGL Import (Extra module) 

Although not as popular as DXF, HPGL is still a common format.   

To import an HPGL file you need to first rename the extension of the file.  Initially the 

extension will probably be “.PLT”.   This needs to be renamed to “.IGL” since PanelMaker 

uses the extension “.PLT” for its own file type which is a different format. 

To be able to rename file extensions in windows, you need to make sure 

windows is displaying the file extensions.  To do this, look at the prosailw 

folder in windows and select “folder options” from the “tools” menu (or go to 

the "Control Panel" and open "Folder Options").  Then click on the “view” tab 

and make sure “hide extensions for known file types” is NOT ticked.   This will 

tell windows to display the entire file name including the extension. 

 

Select Open from the File menu and select “HPGL (*.IGL)” for File of type : 

Make sure HPGL is set to Extended. 

 

HPGL files are read in a similar way as DXF files.  Hence please refer to the previous 

chapter regarding DXF Import from the middle of page 80 onwards. 

The main differences are : 

1) There are no layers in HPGL files, only colours. 

2) Any unit scale can be used.  1016/inch is the most common.  If use saved units 

if available is ticked, the software will look to see if the hpgl file has the units 

specified in the file.  If it does it will use those.   Otherwise it will use the units you 

specify. 
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Export (Extra module) 

These optional export modules allow you to create files of different formats required by 

other CAD software. 

Plot Other : NTV 

 This format is used by PlotterPilot, Dimension Sailcloth and others. 

 

Plot Other : DXF 

 This is the most common CAD format.  Most CAD software will read this 

format. 

 

 

 

 

 

 

 X scale and Y scale are the scale used by the importing software.  A 

value of 1 corresponds to inches.  25.4 will correspond to mm. 

 Tick AAMA if the importing software requires the AAMA format. 

 

Plot Other : Carlson 

 For use with a Carlson plotter. 

Plot Other 
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Nesting Menus 

File 
 New  Create a new rectangular or circular panel. 

 Open Ctrl+O Open an existing panel file. 

 Add F2 Add an existing panel file to the current panels. 

 …………… 

 Save Ctrl+S Save the changes made to the current panels. 

 Save As... Shift+Ctrl+S Save the current panels with a new name. 

 Save a Copy...  Save a copy to a different directory (usually to an 

external device like a memory stick or network). 

 Zoom F4 Zoom the current view. 

 Unzoom F5 Reset the current view. 

 …………… 

 Units  Display the Units Preferences dialogue. 

 Preferences  Display the general preferences dialogue. 

 ...............  

 Quit Ctrl+Q Leave PanelMaker. 
 

 

Edit 
 Shaping Ctrl+F Enter the Shaping Window. 

 ...............  

 Scale  Scale the highlighted panel(s) up or down. 

 Divide  Divide the highlighted panel(s). 
  

 

Nest 
 Group Ctrl+G Group the highlighted panel(s) together. 

 Ungroup  Ungroup the highlighted panel(s). 

 ...............  

 Colour  Change the colour of the highlighted panel(s). 

 Style  Change the style of the highlighted panel(s). 

 ...............  

 Select All/Invert Ctrl+A Invert the current selection of panels. 

 …………… 

 Undo Ctrl+Z Undo the last changes. 

 Redo Shift+Ctrl+Z Redo the last changes. 

 ............... 

 Reset Compact Reset compaction memory. 

 ...............  

 Preferences Display the Nest preferences dialogue. 
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Nesting Menus 

Fabric 
 Plot Options  Displays the Plot Options dialogue. 

 Width Ctrl+W Width of fabric. 

 

 

Print 
 Offsets  Print panel offsets for hand plotting. 

 ...............  

 Screen  Print the window 

 

 

Plot 
 Plot  Start plotting. 

 ............... 

 Move To  Move the plotter to a corner of the table. 

 ............... 

 Setup  Calibrate and test dialogues for the Plotter. 

 ............... 

 Preferences Plotting preferences dialogue. 

 

 

Digitise 
 Digitiser  Connect to the ProSail 2D digitiser. 

 Triangulate Triangulation window for manual digitising. 

 

 

About 
 About  Display information about software version etc. 

 ............... 

 Bug Report Creates a problem report file that can be e-mailed to 

Armstrong-White for problem support. 

 Check Preferences Check all preferences for unusual settings. 


